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Report Maker - General 

Reports may be edited, created from scratch, or an existing report may be copied, and 
changes can be made. To create a report from scratch, a user must go into the Report Maker 
screen and add fields. The fields are then defined and saved. The Report Maker uses visual 
editing so the user will see the format of how the report looks. There are several types of fields. 
Each field type pulls data in a unique manner.   

User Group Rights for Report Maker 
Setting up and editing reports is a User Group right that must be given to users.  By default, 
most user groups do NOT have rights to the setup of Report Maker, unless they are in a 
system supervisor group. 

1. Click American Data – ECS and follow the path Setup > Security > User Group. 

2. Right-click on a user group and select Properties. 

3. On the Rights tab, click the + next to Setup, click the + next to Report, and put a green 
checkmark in the Report Maker checkbox.  

Accessing Report Maker 
Click American Data - ECS and follow the path Setup > Report > Report Maker.  
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Report Icon Key 

 

Open Reports 
Reports may be opened and altered in order to add new fields, delete, move, or change 
existing fields.  

1. Click American Data - ECS and 
follow the path Setup > Report 
> Report Maker.  

2. Click the Open icon .  

3. Select the report to open.  

4. Click OK. 

Reports may be filtered by type. After 
clicking on the Open Reports icon, the 
report selection screen appears. At the 
top of this screen are five choices: All, 
General, Graph, Financial, and Label. 
Selecting one of these choices will 
narrow down the reports listed.  

Open Report Options 
A user can see when a report that has 
been created was last run and can 
choose to mark it as “inactive,” which 
will narrow down the report selection 
list for the end users selecting and 
running reports. 

1. To inactivate a report, click the Open icon .  

2. Select a report on the list and click on Inactivate.  
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3. To activate an inactive report, select the report on the list and click on Activate.  

Select the Type of Field 
Information documented in the record is available to pull to 
reports.  How the information appears on the report 
depends on two things. One is how it was entered into the 
system; reports recognize many of the properties words 
have. For example, question words are used as delimiters in 
some fields. The second thing that affects how information 
appears on reports is what fields are used to pull the 
information and which options are selected within that field. 
Different fields are used to pull different types of information to 
reports.    

 

 

 

 

 

 

 

Field Description 

Text Pulls text to the report.  

Text fields are the most basic fields in Report Maker. This field 
allows users to put labels on reports. These fields are often 
used as titles to other fields. The text in this field remains 
constant, that is it appears the same on reports for all clients. 

Demographics Pulls client demographic information to the report.  

Demographic fields pull information from the client record that 
was entered via the ID icon (or the Demographics screen). 
These fields will pull information for Clients, Providers, and 
Vendors. Demographic data includes name, age, birth date, 
record number, client number, gender, status, Medicaid, social 
security number, Medicare number, SSI, location, facility, floor, 
unit, assign, service. 

View Pulls data entered the chart.  

The View field pulls information from the client record that was 
entered via a documenting screen. A single report may contain 
several view fields of varying sizes. A View field may pull a lot of 
information (e.g., all of nursing notes) or one single piece of 
information (e.g., a room number). 

Column Pulls client demographic data and information documented in 
the chart.  



 

 
 

800.464.9942 | www.american-data.com   4 

Column Fields are unique because they can pull demographic 
information, charting, calendar and formula-based items, and 
this type of field can be set to export data into an Excel 
workbook.  

Frame Frame fields can add character to your reports. These fields 
may be used to created frames, grids, or blocks and can even 
include labels. 

System Pulls computer or settings information to the report.  

System fields pull computer data to reports. Often it is helpful 
to know when a report was printed, for which period a report 
was generated, or even who generated the report. System data 
includes date, time, time period, page number, previous 
month/year, current month/year, next month/year, user’s full 
name and user’s initials.  Other system options are pulled from 
system settings (American Data - ECS > Setup > Settings > 
System). These options include: ID #, Federal #, State # and 
NPI. The System tab defines the field. 

Bar Code Allows printing of bar codes for clients. 

Graph Pulls data entered the chart.   

Graph fields are formatted to illustrate two-dimensional and 
three-dimensional line, bar and pie graphs. Under report 
Options the report type must be set to Graph for printing 
graphs. The Graph tab defines the field. Graph reports can also 
contain equations to calculate and track various rates and 
totals. 

Word Property Pulls word short name, long name, and values to the report.  

This is often used for word setup.  The Word Property tab 
defines the field. 

Picture Pulls picture files to a report.  

This is often utilized for adding facility logos to reports or even 
pulling in a scanned image of a report the facility is using that 
they wish to build into ECS, such as an admission packet or a 
state form. Other report fields can be placed on top of picture 
fields. 

Print Files Prints attachments from ECS. To print these attachments, you 
must have Adobe reader and a default printer established.  
This field is simply a holder so ECS knows to find the file and 
print it. The attachment prints on its own paper (i.e., when you 
add the field to the report, the attachment does not print on 
this report). 
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CAA  
  

Pulls information from the CAA screens. 

Days This creates a field that can count calendar-based items 
between a designated starting and ending time. For example, 
this field can create an Average Length of Stay report for your 
SNF and AL that will count a stay from Admit/Readmit through 
Discharge. 

Signature This field adds a Signature area to allow electronic signatures 
on admissions paperwork, physician order sheets, etc.  

 

Add Fields to Reports 
Fields may be added to existing and new reports. For more detailed information on the 
different fields see Types of Fields and the appropriate screen descriptions.  

1. Click American Data - ECS and follow the path Setup > Report > Report Maker.  

2. Click the Add Field icon . A field selection box appears.  

3. Select the appropriate field type.  

4. Click OK.  

• The Field Properties box appears.  

• All fields have the General Tab.  

5. Make the appropriate changes to the General Tab. This tab typically controls fonts 
and sizing for the entire report. 

6. If the field has a Look tab, make desired selections. Selections in this tab define 
various cosmetic choices used to make the form pleasing to the eye. The setups in this 
tab do not change the content of the report.  

7. Select the field specific tab and make the desired changes.  

8. Click OK when finished making selections and Close.  

9. Move the field to the desired position. 

10. Size the field to appropriate dimensions. To size the field left click and hold while 
pointing to the lower right corner of the field (there is a small box on the corner). Drag 
the lower right corner of the field to the desired size. Any of the boxes appearing on 
the outline of the field may be used for sizing.  

• Text fields, Demographics fields, and System fields should not be manually 
sized. These fields automatically adjust when previewing/printing the report.   

• Column, Sign and Word Properties fields should not have the width manually 
changed. The width of these columns is determined by the width designated 
for each column. 

11. Save the report by selecting the Save As or the Save icon.  
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Move Fields on Reports 
When new fields are created or copied, they are in the upper left corner of the screen. The 
fields are moved to the desired position in the report one of two different ways. If the user 
knows the x and y coordinates of the desired location these may be entered the field 
properties, or the user may drag the field to the desired position. After the field is created or 
copied follow the steps listed below.  

Move Fields by Defining X and Y Coordinates 
1. When in field properties select the General tab.  

2. Define the X coordinate of the field in the Location/Left area.  

3. Define the Y coordinate of the field in the Location/Top area.  

4. Click OK to save the changes.  

Move Fields by Dragging 
1. Left click and hold on the field that is to be moved.  

2. While holding the left-click move the field to the desired position. Release the left-
click when done moving the field.  

Move or Stretch Fields by Using the Keyboard 
1. Left click on the field that is to be moved or stretched.  
2. Hold down the Shift key and use the arrows on the keyboard to stretch a field to make 

it bigger or smaller. 
3. Hold down the Ctrl key and use the arrows on the keyboard to move a field into the 

desired place.  Using the keyboard option helps with more precise accuracy than 
using a mouse. 

Save Reports 
Reports should be saved often. Just like word documents in word processing when the 
computer crashes the unsaved data is lost. Reports may be used as templates to other reports 
by using the Save As feature. American Data encourages this time saving process for creating 
new reports.  

1. Select the Save Reports icon .  

2. Name the report and click OK.  

3. Select the desired facility and click OK.  

4. Select the desired user groups and click OK.  

The report maker runs an error check during the save process. If errors are found, click Yes to 
see the results and fix the issue. When a report has errors the user encounters problems with 
printing and viewing the report.  

Use the Save As Feature 

1. Open a report that is to be saved as a copy. (Select the Open icon , select the 
report, and click OK.)  

2. Select the Save Reports icon .  

3. Type in a new unique name for the report and click OK.  
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4. Select the desired facility(s) and click OK.  

5. Select the desired user groups and click OK.  

6. Make changes to the report and click the Save Reports icon  to save the changes.  

Delete Reports and Fields 
Reports may be deleted from the system. Once a report is deleted it is no longer available for 
printing. If a report is deleted from the system, the only way it may be “brought back” is by re-
creating the report from scratch. ECS has a wealth of reports in the system at the time of 
purchase.  

Delete Reports 
1. Click American Data - ECS and follow the path Setup > Report > Report Maker.   

2. Select the Open Report icon.  

3. Select the report(s) to be deleted.  

4. Click Delete.  

5. Click Yes.  

Delete Fields 
Individual fields may be removed from reports. Once a field is deleted the only way to “bring it 
back” is to re-create the field.  

1. When in the report, highlight the field that is to be deleted.  

2. Click the Delete Field icon  or simply hit Delete on the keyboard. 

Multiple fields may be deleted by selecting more than one field using the Multi-Select icon 

 then clicking the Delete Field icon (or pressing the Delete key). 
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Setup Instructions 

General Tab 

 

Field Name:  Words typed here label the field in report maker (helpful in cases of multiple 
fields) or they can serve as headings for variable height fields.   

Sizing:  Used to control the size of a specific field.  

• Variable to content (Width):  Place a check here to allow the computer to size the field 
based on the amount of data in the field.  If this item is not checked, the user needs to 
size the field manually.  This defaults checked for text, system, and demographic fields.  

• Variable to content (Height): Place a check here to allow the field to stretch vertically in 
order to pull all desired information so another variable height field can begin 
underneath without excess spacing in between or having reports run onto multiple 
pages due to static fields. 

• (Maximum) Width - (Maximum) Height:  The field width and height (in inches) is in this 
area.  The user may type a number in this area to alter the width/height of the field.  

Location:  Displays the placement, or coordinates, of the field on the screen.  When new fields 
are created, they always appear in the upper left corner of the screen. Typically, the field is 
dragged to the desired location.  Another alternative is to alter the coordinates to reflect the 
desired location.   

Field Font/Header Font:  Use these to change the font options of the text in the 
field/header.  Each tab has a [Font] and [Color] button.  The [Font] button allows for font type, 
style, and size selection and the [Color] button allows for color selection. In a case where a 
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report is using the Variable to content (Height) option, a Field Name can serve as a heading 
for that field and the Header Font area controls the font, style, and size of that heading. 

Transparent:  An option that allows removal of the block outline of the field, if checked.  If left 
unchecked, a frame will appear around the field and the field itself will cover anything beneath 
it. 

Look Tab 

Primary Field:  This allows 
the field to be date 
sensitive.  

Master Field: "Hide" blank 
reports by selecting this 
option. Without selecting 
this option, when running 
a report in ECS (e.g., 
physician orders report), a 
report is generated for 
each client selected. In 
other words, if running the 
physician orders report for 
seven residents, you will 
get seven reports listed. If 
two of the seven residents 
have physicians’ orders, 
two reports print with the 
information listed and five 
reports print without any 
information. With this 
option selected, reports 
will not run on clients that don’t have the desired information. 

Isolate:  When "Isolate" is selected, only the words specified in the setup appear in the 
report.  When "Isolate" is not selected, the entire entry appears. When this option is selected 
in "Sign" fields, only the first column is isolated.  

Order - Topic/Chronological/Question/Selected:  Defines the order in which the data will 
appear within the specific field. Placing a check in "Reverse" list the information in the reverse 
of the order selected, for example, reverse chronological lists data from the most recent first 
then progresses backward in time.   

• Topic Order - the information appears in the order the topics are listed in the field 
setup.  

• Chronological Order - the information appears in chronological order.  
• Question Order - the information appears in the order the question words are listed in 

the field setup.    



 

 
 

800.464.9942 | www.american-data.com   10 

• Selected Order - the information appears in the order the words are in the field setup. 
This is like question order, however; "selected order" does not group words by topic.  

• Sort Within Each Column – (Column field) Within each column, the data that appears 
will be sorted by whichever option above is selected. 

Process Options: this area is available on the Look Tab for column fields only  

• One Line per Entry:  Creates one line for each entry across all columns.    
• One Line per Topic:  Creates one line for each topic across all columns.    
• One Line per Client:  Keeps each entry for a specific client together across the 

columns.  If this is not selected, the information for an individual client may appear 
staggered across the columns and no lines appear to separate each client.  Note that 
“Multiple Names per Report” would also need to be selected (using the Options icon).  

• One Topic per Page:  This option separates topics by page when printing. This is useful 
in printing care plans when facilities would like each care plan to print on its own sheet 
of paper.    

Composite:  Defines the values for the overall report.   

• Average of Values- shows the total values of all the averages selected.  
• Average of Totals - shows the averages of all the total values selected.  

Split/Page (Row, Entry): Select the Entry or Row checkbox if you want to split entries, client 
information, or rows between pages. There may be circumstances where you do not want this 
checkbox selected because you want information together on one page. For example, when 
printing a care plan report, the report by default splits entries and/or rows between pages, so 
you may end up with part of a care plan approach on the bottom of one page, and then finish 
on the top of another page. This can be cumbersome to read. If the checkboxes are not 
selected, the entire approach would carry over to the top of the next page if the entire entry 
did not fit on the bottom of the first page. In addition, rather than just making the entry not 
split, you can disable the split between row, so the entire care plan will start on a new page if it 
does not fit on the bottom of the first. 

Column:  This area is available on the Look Tab when editing a column field.  

• Vertical Column Heading:  Prints the Column Heading words up and down instead of 
across, allowing the column width to be minimal.  Use this for columns which will not 
be very wide, as in Yes/No columns.  

• Alternate Column Shading:  Causes every other column within the specific field to be 
lightly shaded when it prints.  This makes it easier to find information on a grid of 
columns, such as are found on a Medication sheet.  

• Percentage: Sets the column to show a percentage.    
• Show Names Without Data:  When set, the names of clients not containing the 

information requested on the report appear.  When not set, only the names of clients 
containing information requested appear on the report.  

Spacing:  Defines various options to cosmetically separate the entries or topics.  Options 
include: a line after topics, space after topics, line after entries, space after entries, and no 



 

 
 

800.464.9942 | www.american-data.com   11 

lines. If none of these options are selected, there will be no spaces or lines between entries or 
topics.  More than one option may be chosen, if desired. By default, column fields have lines 
drawn between entries, if no lines are desired the user may need to select "No Lines" in this 
area.   

Report:  Further defines values for the overall report.  

• Average of Average - shows the average value of all the values selected.  
• Total - shows the total value of all columns per column.  
• Name Total – provides a total for the number of clients appearing in the report. 

Formulary Side Effects:  American Data's Electronic Chart System has a pharmacy formulary 
embedded within the system. When a facility uses this formulary, they may select filters for 
side effects. The side effect filters include severity [mild (rash) to severe (death)], incidence 
[common (diarrhea) to rarely seen (death)] and documentation [this is how much documented 
evidence is found in clinical literature]. Place your cursor on a slider, hold the mouse button 
down and move to a slide bar position to see a more detailed explanation of that level of 
filter.   

Export: Select this checkbox to be able to turn this report into a data file that can be used in 
other programs like Excel for further analysis of the data. Selecting this checkbox will add an 
Export button on your toolbar when previewing the report. Click this button, enter a file name, 
and select a location of where you would like to save the file. The file will be exported and 
saved as a .csv file which can then be opened using Excel. 

**View fields have an additional option on the Look tab. "Frame Offset", allows the user to put 
a frame around the view field. The number designated represents the number of pixels for the 
width of the frame. The frame color may be selected by clicking Frame Color. 
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View Tab 

 

View:  Defines the list of topics, specific words, or days which have been chosen for the view 
field.  If this is not defined the field will be blank.  

• Add/Remove:  Click Add to bring up the topic selection screen.  The topics and words 
are added to the bottom of the list.  Click Remove to remove the highlighted 
topic/word from the list.  

• Use Insert to add a topic/word to a location in the list.  The topic/word is inserted 
above the topic/word highlighted in the list.  

• Up/Down:  Select a topic/word from the list and click Up or Down to move it to another 
position in the list.  The items may not be moved when the field is set to View in Topic 
Order.  

• Days:  Sets the desired number of Days to be included for the specific topic/word.  If 
no Days are set the selections are made from the entire record.  To set the number of 
days highlight the topic/word and then click Days.  Type the desired number of Days 
and click OK.  

• Group:  Assigns the topic or word to a group.  To set a topic or word to a group 
highlight the topic/word and click Group.  A box appears set the desired group and 
click OK.  To remove a group, highlight the topic/word, click Group and assign a group 
of “0” and click OK. For example, if there are three words from a single topic in the list 
and the last entry entered for each one is what should display, each word must be set 
to its own group.  And on the contrary, if the last entry of any of three different word 
options is desired, all three items would need to be set to be the same group. 

• +/-:  Makes the word positive or negative.  This is most often used for billing reports.  
• Formula: This allows for a formula to be added into a view field, therefore able to more 

narrowly determine the data that populates.  For example, if a user wants the 
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CONTACT NAME for only the Healthcare representative to display, then a formula may 
be added to state, “If Any of – Healthcare representative.”  This will narrow down the 
entry that displays in the view field to only pull data IF the formula applies.  

Include:  Defines the type of entries to be included in the field. D/C’d and Current Entries may 
be both selected but when Current in Period is used this should be the only one selected.   

• D/C’d Entries pulls discontinued entries to this field in the report.     
• Current Entries pulls current entries to this field in the report.  
• Current in Period pulls entries that were current during the time period specified when 

running the report.  (This means the entries may now be discontinued).  
• Held Entries pulls entries in a held status into this field in the report. Held entries 

appear with *********HELD ENTRY********* in front of them.  
• Use Start Date sets the report to pull data only from a client's most recent stay. For 

example, if a client has been to the facility twice, then with this checkbox selected, only 
the data from the second stay will appear on the before. Before this setting can take 
effect, initial setup must be in place in File > Setup > System Settings > Review > Start 
Date Word.  

Show Values:  Defines what aspect of the value is desired.   

• All Values lists all the individual values.  
• Total Values shows the total of all values.  
• Average Values shows the average of all values.  
• None specifies that no values are to show.  

Value (button):  This defines information to be pulled from the values tab in word properties.  

Identifiers:  Defines information regarding entry date, entry time or author’s name to be 
placed within the highlighted column. When Show CoSign is selected, the view screen 
displays the date and initials of the user who cosigned the entry via the Electronic Co-Sign 
feature in ECS. Select Last Signature to have only the most recent co-signature displayed on 
the entry rather than ALL co-signatures for the entry.  To have any of the identifiers repeat per 
entry, place a checkmark in the appropriate Repeat option.  If not checked, when there are 
several entries with the same date, time, user initials, etc. the identifier will not repeat to the 
left of the entry.   

NOTE: To display the full name of the user who co-signed an entry the report must have both 
"Show Co-Sign" selected and "Show Initial Name" selected. You many also need or choose to 
have "Repeat Initial Name" selected.  

Other:  Controls the format and content of the field.  

• Concealed:  Allows concealed words to print in the field. If this selection is not checked 
concealed words will not print within the field. An example of concealed words is side 
effects for medications. There may be up to 16 levels of concealed words. To select a 
level, click the pick list box and select a level (multiple may be selected).  For more 
information on concealed words see the Word Setup portion of the manual.  
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• Word:  Used to pull the specific word itself from the documentation. Surrounding 
words or typed text would not be included.  For example, the word INCIDENT would 
appear, but not INCIDENT: fall.  This is usually chosen in conjunction with What follows 
word to avoid that circumstance.  

• What Follows Word:  Pulls the text which follows the word in the documentation.  This 
does not pull the defined word itself but the text after it.  This option may be used with 
Button or Non-Button words however most frequently it is used with Button Words. 
Surrounding words and typed text are included but not the word itself.  This selection 
may be chosen in conjunction with Word.  

• Yes/No Only:  Places an X within the field when the content designated for the field is 
present.     

• Last Entry:  Used to pull only the most recent entry as defined in the field.  Previous 
entries are not included in the field even if they remain current when this selection is 
made.     

• Discard Beyond Field:  Discards data that does not fit in the field.  This prevents reports 
from going into an infinite loop.  This also prints the information on successive 
pages.  An example of this is a view field that pulls room number.  The room number 
would print on page 1, page 2, etc.  

• Repeat if Multiple Pages: Select this checkbox if the report might have subsequent 
pages and this should print on all of them.  

• Last Word Use:  Pulls the last time a word was used within an entry.  This may be useful 
when capturing the last time something was evaluated.  Many times, when something 
is evaluated the user appends the original entry with a date of evaluation.     

• Use Link:  Some clients in the system may have other clients linked to their record (e.g. 
husband and wife may be linked).  When the report is to pull information for the 
specified client, and anyone linked to that client place a check here.  

• Indent:  When indent is selected the report recognizes word properties for 
formatting.  When this is not selected the information is shown without formatting.  

• Combine Entries: Use this property to display information from left to right in the 
report instead of top to bottom. For example, suppose a resident has the question 
word ALLERGIES: used multiple times. Without using this property, the report will list 
those multiple entries from top to bottom. This property will display the allergies from 
left to right, ensuring that all allergies can be displayed on one page.  

• Identifier Only: When this is checked, only the item(s) checked under the Identifier 
section (Show Dates, Show Time, Show Initials, Show Initial Name) of the field will 
display.  For this option to work correctly, there must be data in the Review Words, 
something checked under Show, as well as something checked under Include.   

Link View Fields:  This may only be used on label reports.  One field may be made to be 
dependent upon another field. Use Add to define the field being linked.  Use Remove to 
remove the defined field. 
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Column Tab 

 

Columns: This box will display columns in your report and their information. 

• Add:  Allows you to add a column to the field and to give the column a name.  When 
this is clicked an Add Column box appears.  Type in the name of the heading and click 
OK.   If other columns have already been set up the new column appears at the end of 
the list.  

• Insert:  Allows you to insert a column into a position in a list of existing 
columns.  Highlight the column just below where the new column is to appear.  Click 
Insert and an Add Column box appears.  Type in the name of the heading and click 
OK.  

• Remove:  Removes a column heading.  Highlight the desired column then click 
Remove.  

• Rename:  Allows you to rename an already existing column.  
• Copy:  Select a column to copy and click Copy Column the button changes to Paste 

Column. Click Paste Column and the column pastes to the bottom of the list. The user 
may click the Paste button multiple times.  

• Up/Down:  Clicking on Column Up or Column Down moves the highlighted column 
up/down the list.  

• Group:  Allows the grouping of Columns together for purposes of selecting 
topics/words for consideration (this is especially useful for reports with Yes/No 
columns).  For example:  Independent, Supervised, Limited, Extensive and Total Assist 
for Bathing may comprise a group.  The last documented response within the group is 
considered.  Highlight the desired Column, click Group, designate the group number, 
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and click OK. Click Remove to remove the group. The Column will remain but its 
designation as part of a group is removed.  

• Period:  Period allows a period to be designated per column.  Highlight the column 
and click Add Period.  A Select Period box appears.  Designate the period and click 
OK. Click Remove to remove a period from a column.  

Column - Based On: The report can be set to pull information per column. For example, I have 
a report that has a total of 5 columns. Of those 5 columns I would like 4 of them to pull 
information to the column based on the date the entry was made and 1 column to pull 
information based on the date in the entry.  

• Entries: Entry Date —Pulls information based on the date of the entry (the date the entry 
was made).  This is the default  

• Calendar:  Pulls information based on the date in the entry.  To set this up click the pick 
list box. Select the column that includes the calendar word and click OK. To Remove a 
column from the list, click the pick list box and click OK without highlighting any 
columns.  

• Formula. Pulls information based on a selected formula. Click the picklist box and 
select a formula.  

• Demographics:  Defines the content of the highlighted column to pull information 
from the Demographic portion of the program. Client demographics, Provider 
demographics and Vendor demographics may be pulled to reports. Click Clear to 
clear the demographics from a specific column.    

Width: Sets the width (in inches) of the highlighted column. A width must be individually set 
for each column.  

Format: Formats columns.  The data may be formatted to appear in Text Money Format, the 
decimal may be dropped, and/or values may be right or left justified, or centered.   

Sort By:  Sort tasks may be linked to a column report (e.g. room number order).  Click on the 
pull-down arrow to select the desired sort task.  

LPW Col: (Line Per Word) This gives you the ability to have words in the chosen column pull, 
even if there is a not a resident charted with that word the day it is ran. This could be used to 
create a room list report that pulls the room even if it is empty. 

Options: 

• Required:  This allows for filtering data that pulls to the report. As an example, you 
could create a column report that has 3 columns: 1) resident name, 2) room number 
and 3) pressure sore. If you do not have this "Required" option selected, you will have a 
report that prints all in -house clients who have a room number (i.e. everyone). This is 
not the intent of the report. If you were to place a check in "Required" for column #3 
(pressure sore) your report will pull only those residents who have pressure sore 
documented in their chart. This option is used to define the report.  
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• Disable Total:  Used to disable the Totaling feature for individual columns.  If the report 
is set to “Total” (on the Look tab) placing a check here disables the totaling for the 
column selected.  

• Disable Primary Field:  Used to disable the Primary Field feature for individual 
columns.  If the report is set to “Primary Field” (on the Look tab) placing a check here 
disables the primary field for the column selected.  

• One User Per Column: This is an option independent of the date option above. This 
option works in conjunction with selecting users when generating the report. For 
example, I may wish to evaluate productivity of staff members based on information 
they document in the system.  

• Use Link:  Some clients in the system may have other clients linked to their record (e.g. 
husband and wife may be linked).  When the report is to pull information for the 
specified client, and anyone linked to that client place a check here.  

• Repeat Column: When this is checked on a column, the information in that column will 
repeat for every row of information, regardless of other settings on the report, like 
“Line per Entry.”  This feature is beneficial if the report is to be exported, so that each 
row of data has identifiers associated with it.  One Line Per Entry on the Look tab must 
be active to utilize this option.   

• Identifier Only: When this is checked, only the item(s) checked under the Identifier 
section (Show Dates, Show Time, Show Initials, Show Initial Name) of the field will 
display.  For this option to work correctly, there must be data in the Review Words, 
something checked under Show, as well as something checked under Include.   

Period: When using periods in a column report the user may display either the date range of 
the period in the column heading or the end date for the period in the column heading.  

Review – Words: This is where you can specify which information should be pulled to the 
report. Topics and/or words are listed here by clicking Add to call the topic selection 
screen.  Using Insert allows a topic/word to be inserted anywhere in the list (will always be 
inserted above the highlighted link). To remove a link highlight it and click Remove.  

• Days:  Sets the desired number of Days to be included for the specific topic/word.  If 
no Days are set the selections are made from the entire record.  To set the number of 
days highlight the topic/word and then click Days.  Type the desired number of Days 
and click OK.  

• Group:  Assigns the topic or word to a group.  To set a topic or word to a group 
highlight the topic/word and click Group.  A box appears set the desired group and 
click OK.  To remove a group, highlight the topic/word, click Group and assign a group 
of “0” and click OK.  

• +/-:  Makes the word positive or negative.  This is most often used for billing reports.  
• Copy: Allows the user to copy and paste links from one column to another.  Highlight 

the links to be copied and click on Copy (this button then changes to read 
Paste).  Navigate to the column the links are to be pasted and click on Paste.  

• Up/Down: Allows the user to move links up or down in the list.  

 

 



 

 
 

800.464.9942 | www.american-data.com   18 

Show: 

• Word:  Used to pull the specific word itself from the documentation. Surrounding 
words or typed text would not be included.  For example, the word INCIDENT would 
appear, but not INCIDENT: fall.  This is usually chosen in conjunction with What follows 
word to avoid that circumstance.  

• What Follows Word:  Pulls the text which follows the word in the documentation.  This 
does not pull the defined word itself but the text after it.  This option is most often used 
with Question Words. Surrounding words and typed text are included but not the word 
itself.  This selection may be chosen in conjunction with Word.  

• Yes/No Only:  Places an X within the field when the content designated for the field is 
present.     

• Concealed:  Allows concealed words to print in the field. If this selection is not checked 
concealed words will not print within the field. An example of concealed words is side 
effects for medications. There may be up to 16 levels of concealed words. To select a 
level, click the pick list box and select a level (multiple may be selected).  For more 
information on concealed words see the Word Setup portion of the manual.  

• Indent: When this is selected the report recognizes word properties for formatting. 
When this is not selected the information is shown without formatting.    

Include: Defines the type of entries to be included in the column.   When a column is created 
Current Entries is the default.  D/C’d and Current Entries may be selected at the same 
time.  Current in Period should be used by itself. 

• Current Entries pulls current entries to this field in the report.  
• D/C’d Entries pulls discontinued entries to this field in the report.  
• Current in Period pulls entries that were current during the time period specified when 

running the report.  (This means the entries may now be discontinued.)  
• Held Entries pulls entries in a held status into this field in the report. Held entries 

appear with *********HELD ENTRY********* in front of them.  
• Use Start Date pulls entries for the most recent admission (stay). For this option to 

function the system administrator must have the settings for "Start Date" in File > Setup 
> System Settings - "Review Tab".  

• Last Entry:  Used to pull only the most recent entry as defined in the field.  Previous 
entries are not included in the field even if they remain current when this selection is 
made.     

Show Values:  Defines what aspect of the value is desired.  

• All Values - lists all the individual values.  
• Total values - shows the total of all values.  
• Average Values - shows the average of all values.  
• None - shows no values.  
• Value button - defines information to be pulled from the Values tab in Word Properties.  

Identifiers: Defines information regarding entry date, entry time or author’s name to be placed 
within the highlighted column. The option In Line adjusts the identifiers to be on the same line 
as the entry (as opposed to being on the top of the entry). When Show CoSign is selected, the 
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view screen displays the date and initials of the user who cosigned the entry via the Electronic 
Co-Sign feature in ECS. Select Last Signature to have only the most recent co-signature 
displayed on the entry rather than ALL co-signatures for the entry. 

Frame Tab 

 
 

Frame fields may be used to created frames, grids, or blocks. 
• To create a frame: Click the Add Field icon, select Frame, and click Close. Resize the 

frame by pulling on the edges. The field may be layered behind another field.  
• To create a grid: Click the Add Field icon, select Frame, and define the Rows and 

Columns.  
• To create a block: Click the Add Field icon, select Frame, select the General tab, 

change the background color, and click Close.  

Frame Columns: Frame fields can be boxes or grids.  Define the # of columns desired.  

Column width may be adjusted by clicking on the +/- buttons or manually entering a 
number.  The width is in inches.  

Frame Rows:  Frame fields can be boxes or grids.  Define the # of row desired.  

Row height may be adjusted by clicking on the +/- buttons or manually entering a 
number.  The height is in inches.  

Color: The color of the frame field may be altered by clicking Color.  

Repeat if Multiple Pages: Select this checkbox if the report might have subsequent pages and 
this should print on all of them.   
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System Tab 

 

Click on the pull-down arrow to the right of Type of Field.  A menu appears with the following 
options:  

• Standard:  Prints the facility’s/corporation’s name and city, the current date and time, 
and page numbers  

• Site: Print the facility's/corporation's name on the report. This comes from the setup of 
facility information.     

• City:  Prints the facility’s/corporation’s city on the report.  This comes from the setup of 
facility information.  

• Date:  Prints the date the report was printed.  
• Time:  Prints the time the report was printed.  
• Page:  Prints page numbers on the report.  The format is “Page __”.  
• Period:  Prints the start date and end date the user selected when printing the report.  
• Previous Month/Year:  Prints the previous month along with the year on the report.  
• Current Month/Year:  Prints the current month along with the year on the report.  This 

is often used for printing paper MARs for new admissions.  
• Next Month/Year:  Prints next month along with the year on the report.  This is often 

used for printing paper MARs.  
• Next Day/Year:   Prints tomorrow's day and year on the report.  This is often used for 

printing daily MARs or flow sheets.  
• User’s Full Name:  Displays the full name of the user who is printing the report.  
• User’s Initials:  Displays the initials of the user who is printing the report.  

You can select one of the following fields from the ID tab in Site Settings: 

• ID 
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• Federal (Medicare) 
• State (Medicaid) 
• NPI 

You can also select one of the following fields from the Financial tab in Site Settings: 

• Name 
• Address 
• City 
• State 
• ZIP Code 
• Phone 
• Contact 
• Federal Tax Number 

Repeat if Multiple Pages: Select this checkbox if the report might have subsequent pages and 
this should print on all of them.   

CAAs Tab 

 
The box on the left side of the screen is where the CAAs are listed when they are included in 
the report setup.  
 
Add:  Defines which specific CAAs are to be pulled in the field. Click Add and highlight the 
desired CAAs. To add multiple CAAs, hold down CTRL or SHIFT on the keyboard when 
selecting them. CAAs are added to the bottom of the list as they are selected.  
 
Delete:  Removes CAAs from the field. To remove a CAA highlight it and click Delete. To 
remove multiple CAAs hold down CTRL or SHIFT as they are highlighted.  
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Identifiers:  Defines information regarding entry date, entry time, or author’s name to be 
placed within the highlighted column.  The option "In-Line" will place dates/times on the same 
line as the data (by default the dates/times are listed on a separate line). The option "Indent" 
places the designated # of inches between Question Words and Canned Phrases. Selections 
from this list are optional.  
 

Bar Code Tab 
The Bar Code field allows 
for printing client bar 
codes.  Create a report with 
this field.  The field does not 
need to be defined (this is 
its only purpose).  
 

Graph Tab 
When a user chooses to 
create a graph field, they are 
presented with a menu to 
define what type of graph to 
create. Options for graph 
type include: Bar, Line, Pie 
and Gauge. When a graph 
field is created there are 2 tabs 
presented to define the graph: 
"Properties" and "Elements".  
 
The Properties 
tab is where the 
user defines the 
general 
properties of the 
graph. Each 
graph type has 
its own 
properties in the 
lower left corner. 
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Alignment  

• Left: the user can specify where the title/footer will be placed on a report.  "Left" is 
selected if the title/footer is to be aligned on the left side of the report.  

• Center: the user can specify where the title/footer will be placed on a report.  "Center" 
is selected if the title/footer is to be aligned in the center of the report.  

• Right: the user can specify where the title/footer will be placed on a report.  "Right" is 
selected if the title/footer is to be aligned on the right side of the report.  

Period checkbox: When this option is checked the field will reflect the date range that is set on 
the Properties tab. This is useful when printing pie graphs and gauge graphs. If you would like 
the time period, the graph is illustrating to print (e.g. pie graph generating data from the past 
year) you must put a check in this property "Period". For example, if the field is set to look back 
"Start 30 Days Ago", the period field will count back 30 days from the report is generated and 
display that date range at the top of the field on the report.  

Legend: The Legend is the description of the bars/lines or slices on the graph.  Place a check 
in "Not Visible" to hide the Legend on the report.  

Replace Dates with Element Names: When bar graphs are generated, the dates, by default, 
appear under each bar to show the user the range of dates that each bar represents. When 
Replace Dates with Element Names is selected, the dates will no longer appear under the bar. 
Instead, the actual name of the element appears. For example, if there are two elements 
named "Element A" and "Element B" and the bar graph is set up to look back 12 months in 1-
month increments, when the bar graph is generated, each month date range will appear 
under the element. When Replace Dates with Element Names is then selected, the user will 
see the name Element A and Element B under the bar instead of the date ranges.  

Replace Date with Month Name: When bar graphs are generated, the dates appear under 
each bar to show the user the range of dates that each bar represents. When the graph is set 
to increment by month, the option Replace Date with Month Name becomes available. When 
this checkbox is selected, the dates appear as month names on the graph. For example, 
02/01/2012-02/28/2012 becomes February. 

Separate by Site/Service: Select this checkbox to display bar graphs representing multiple 
sites and multiple services. 

Graph Type: Select the graph type (bar, line, pie, or gauge). 

3D  

• 3 Dimensional: When this is selected, the graph is displayed in 3D.  
• 3D %:  Select this checkbox to manually specify how the 3D will appear on the Graph 

report.  Use the 3D % pick box to specify the percent.  
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Axis  

• Left Axis:  The Left Axis are the numbers that appear on the left side of the graph.  The 
maximum and minimum numbers and increments may be specified.  

• Bottom Axis:  The Bottom Axis is the numbers/dates that appear on the bottom of the 
graph. The maximum and minimum numbers and increments may be specified.  

• Not Visible:  Placing a check in "Not Visible" hides the Left and or Bottom Axis from the 
Graph report.  

• Auto Maximum:  Auto is set as the default.  The computer automatically configures the 
Maximum axis for the Graph report.  Remove the check from Auto to create your own 
Maximum axis.  

• Auto Minimum:  Auto is set as the default.  The computer automatically configures the 
Minimum axis for the Graph report.  Remove the check from Auto to create your own 
Minimum axis.  

• Auto Increment:  Auto is set as the default.  The computer automatically configures the 
Increment for the Graph report.  Remove the check from Auto to create your own 
Increment  

• Title:  A Title can appear by the Left and the Bottom Axis to specify what is being 
graphed.  Click on the desired axis to specify what the title will read (e.g. Left Axis-
Weight, Bottom Axis-Weights for Past 6 Months in 1-month Increments).  

Sample:  Click Sample to see a sample of how the Graph report will appear.  

Start: This is where the beginning time frame for gathering data for each element is defined. 
Highlight the start field and either type in the desired number of hours, days, weeks, or 
months upon which you wish this element to begin looking at data or use the up/down 
arrows. Select Hours, Days, Weeks, or Months from the Ago area. If a start number for each 
element is not defined, the graph will likely not contain any information as the default setting is 
1 Day Ago.  

Series: The blocks of time in the breakdown of the graph. For example, if a user wanted to 
evaluate the number of falls quarterly, they would set the series to 3 and Increments to Month. 
Increments are hours, days, weeks, or months.   

Value Calculation 

• Count Words/Values - This defines the type of calculation to be used when 
determining the percentages used on the graph. It sets the graph to count the number 
of words/values used. For example, this may be used when setting up a graph to count 
the specific number of activities attended by an individual resident.  

• Count Clients - This defines the type of calculation to be used when determining the 
percentages used on the graph. Count Clients sets the graph to count the number of 
clients. For example, this may be used when setting up a graph to count the number of 
residents receiving psychotropic medications. 

The Elements tab is where the user defines the specifics of the graph. 
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Elements table 

Add:  Allows user to add an element to the field and to give the element a name. When this is 
clicked on an Element box appears. Type in the name of the element and click OK. If other 
elements have already been set up the new element appears at the end of the list in the box 
on the left. This heading appears on the graph  

Element Properties  

One User Per Element: When this option is selected, the report compares information from 
one user against another (i.e. physical therapy minutes for all the physical therapy staff). Each 
user must have their own individual element created for comparison, so if there are 4 users 
being compared, 4 separate elements must be created. 

For each element, select the One User Per Element checkbox and the Calendar Date 
checkbox and make any other setup changes needed. 

Multiple Clients per Report must be selected from the Options area in Report Maker if 
multiple users are to be compared in the same report. If viewing only one users information 
per report, do not select the Leave Multiple Clients per Report checkbox in the Options area. 
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Show Labels:  When this is selected, labels appear on the graph element.   

Auto Color:  When this is selected, the computer assigns colors to each element.  

Color:  Click on this button to assign the color of your choice to an element.  

Words - List View: The information that is to pull to the graph is defined here. Click Add to add 
words to the setup. Click Insert to insert words into an already existing list. Click Remove to 
remove a highlighted/selected word from the list.  

Based On: Specifies how the graph is to pull data from the specified time period  

• Entry Date:  Pulls information based on the date of the entry (the date the entry was 
made). This is the default.  

• Calendar Date:  Pulls information based on the date in the entry. To set this up click the 
pick list box. Select the column that includes the calendar word and click OK. To 
Remove a column from the list, click the pick list box and click OK without highlight any 
columns.  

• Formula: Formulas may be linked to graphing fields. Formulas allow for more specific 
data to be pulled to the graph. For example, you may wish to have a graph pull all falls 
without follow-up documentation compare to falls with follow-up documentation. The 
formula is first created (IF ANY OF: fall AND NOT: follow-up then pull the number of 
occurrences) (IF ANY OF: fall: AND: FOLLOW-UP then pull the number of occurrences) 
and then it is linked to the graphing element.    

Include: Defines the type of entries to be included in the graph. D/C’d and Current Entries 
may be selected at the same time. Current in Period should be used by itself.  

• D/C’d Entries pulls discontinued entries to this field in the report.  
• Current Entries pulls current entries to this field in the report.  
• Current in Period pulls entries that were current during the time period specified when 

running the report.  (This means the entries may now be discontinued).  
• Use Start Date pulls entries for the most recent admission (stay). For this option to 

function the system administrator must have the settings for "Start Date" in File > Setup 
> System Settings - "Review Tab".  

Show Values: Defines what aspect of the value is desired.  

• Total Values shows the total of all values.  
• Average Values shows the average of all values.  
• All Values shows all values during the designated time period.    
• Value Button: This defines information to be pulled from the values tab in word 

properties.  

Other: Controls the format and content of the field.  

• Word:  Used to pull the specific word itself from the documentation. Surrounding 
words or typed text would not be included.  
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• What Follows Word:  Pulls the text which follows the word in the documentation. This 
does not pull the defined word itself but the text after it. This option may be used with 
Button or Non-Button words however most frequently it is used with Button Words. 
Surrounding words and typed text are included but not the word itself.    

• Yes/No Only:  Places an X within the field when the content designated for the field is 
present.     

• Last Entry:  Used to pull only the most recent entry as defined in the field. Previous 
entries are not included in the field even if they remain current when this selection is 
made.     

Logo Tab 
When setting up a Picture field 
in ECS, click "Find Picture" on 
the Logo tab. Browse to find 
the desired image, select it 
and click OK. You can choose 
to use the "Variable to Content 
(Width)" option on the General 
tab. Clicking Close on the field 
properties box closes the 
setup screen and the user now 
sees the image on the report. 
The image may be moved or 
resized (if not using the 
"Variable to Content (Width") 
feature).  
 
Repeat if Multiple Pages: 
Select this checkbox if the 
report might have subsequent pages and this should print on all of them.  
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Signature Tab 

 

Identifier - Enter a unique name or label used to group signature boxes when wanting to run 
multiple reports and only having to sign once. 

  To create an identifier, click Edit next to the picklist 
box. 

1. Create a new identifier by clicking 
Add and entering a name.   

2. To rename an existing identifier, 
highlight the name and click Edit. 

3. To delete a modifier, highlight the 
name and click Delete. 

4. When you are finished in this window, 
click OK to save any changes. 

 
Title - Enter a name used to distinguish one signature 
field from another. The title may be different for every 
signature field; therefore, they are not saved in a list like the identifiers. To give a signature 
field a title, click in the box next to Title and create a name. 

Overall Report Options 

To access the overall report options, click onto the hammer/wrench icon .   
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Report Locked by User: Select this checkbox to lock all other users from making changes to 
the report. The user who enabled the lock is listed here. 

Margins: Defines the margins of the report.  The default settings are 0.50 in each option.  
Typically, these are not adjusted unless creating a report which produces labels.   

Size  

Height and Width:  Defines the size of the paper upon which the report prints. The default 
setting is 11 inches height and 8.5-inch width. Most reports are printed on this size of paper. 

Options - Multiple Clients per Report: Select this checkbox to have more than one resident 
print on a report. When this checkbox is not selected, each resident appears on a separate 
report. 

Disable Footer: Select this checkbox to remove the footer from the printed report. 

Copies: Determines how many copies of the report will print. The default setting is 0, which 
produces one copy of the report. 

Tasks  

Common and Sort: Common tasks and Sort tasks may be linked to a report. Linking these 
decreases the number of keystrokes for generating reports. 
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Label: Specifies the format for labels.  

Left Side Spacing:  defines where the left border of the first label is positioned from the left 
side of the label sheet  

Top Spacing:  defines where the top border of the labels is from the top side of the label sheet  

Between Label Spacing (vertical):  Defines amount of space is vertically between labels.  

Between Label Spacing (horizontal):  Defines amount of space is horizontally between labels.  

Number of Label Columns:  Defines how many columns of labels are on the label sheet  

Number of Labels in Columns:  Defines how many labels are in each column on the label 
sheet  

One Entry per Label:  Specifies that each entry is to print on a separate label.  

One Entry per Field:  Prints one entry per field per label.  

Report Type: Defines the type of Report which enables various options on the field set up 
screen. Choices include: General (the default setting, used for most Clinical reports), Graph, 
Financial, and Label Report. Financial reports are further broken down to include AR (accounts 
receivable), AP (accounts payable) and Payroll.  

Orientation: Determines the direction on the paper in which the report prints. The default 
setting is portrait.  

Report ID:  Used for technical assistance.  

Site/Group:  Allows for the selection of facilities and groups that may access the report. 

Dates: When you click the Dates button, a new Date Selection form appears. You have the 
option of specifying a start date. An example when you may want to use this for is the Therapy 
Cap summaries. Set the Start date for January 1st and it will pull the current year. This will 
automatically update each year so there is no need to reset this date in subsequent years. 

By default, reports are set to No Dates. This means that ECS is not selecting dates for the user, 
but the user still can select dates if they want. Please keep in mind the Primary Field property. 
Remember that only fields with this property respect these date selections. 

Choosing Force Selection requires the user to select desired dates when running the report. 
Selecting any of the other options saves the user from needing to select dates, ECS will do this 
for them (thus saving them time!). 

Time From/Time To: A report can be set to run for certain time spans during the day.  Foe 
example, 7pm-7am.  This may be useful so that facilities who utilize 12-hour shifts can run 
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reports for the night shift that accurately reflect the charting that was done throughout the 
entire shift.  These time words should be set to the start time – end time of the shift, so that it 
will run for that same time each day.   

Error Check  

Error Check 

Each time the ECS system administrator saves a change to a report, ECS runs an error check. If 
errors are found ECS asks the user if they would like to review the list. Users have the option of 
ignoring the error check; however, be warned that this might cause your report to fail/not 
function appropriately. 

On reports with multiple fields it can be difficult to determine which field the error is contained 
in. One method for finding the appropriate field is to highlight the Error or Warning and click 
the Go to Problem button. 

Tips and Tricks 

Move Multiple Fields at Once 
When setting up a report, you may find that you need to move multiple fields at one time. For 
example, you set up three fields on the right side of the screen but need to move them to the 
left side. You can click into the Report Maker screen and drag your mouse over the fields you 
wish to move. Once the fields are highlighted, you can move all three of the fields together. 
These fields do not need to be moved individually and then re-aligned.  

 

Primary Field and Disable Primary Field 
Giving a field this property signals the report engine to honor the selections made in the 
Report Selection screen. If you look at the image below, the Period, Date/Time, Topic, and 
User’s information (circled in the image) affect only those fields with Primary Field selected on 
the Look tab. Fields that do not have the Primary Field option selected will ignore the Report 
Selection filter specified. 

Column fields are unique in that these pull a large amount of information and the information 
pulls from various areas within the electronic chart. It is possible that you may want one 
column to have the Primary field option but another column to ignore this function. Therefore, 
the Disable Primary Field option was created. 

For example, a column report pulls the resident’s name, room number, and new falls within 
the time period selected. When the column ‘room number’ is set to pull ‘Current Entries’ you 
will find that many of your residents will have an empty room number result on this report.  

Set Fields as Required 
As previously stated, column fields can be set up to pull a large amount of information from 
several areas of ECS. Often, we hear requests for assistance with filtering data that pulls to 
these reports.  
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For example, a column report pulls the resident’s name, room number, and new falls within 
the time selected. The only residents you would like to have pull to this report are those who 
have had a fall or incident in the time period selected when generating the report. This can be 
done by using the Required option for the desired column. This option is found in the column 
field Column tab in the Other panel. This option may be used on more than one column in a 
report. If we look at this example, we could require both a fall/incident and the presence of a 
psychotropic medication on the resident’s chart. 

Pull Information from Particular Time Periods 
Periods have been a capability in ECS for several years now and as more people utilize this 
feature the more refined it is becoming. As review, a report may be setup to pull information 
from a time period in separate columns. For example, review of blood sugars over the past 
month. You can create a column report with four columns; the first column reviews data from 4 
weeks ago, the second column reviews data from 3 weeks ago, the third column reviews data 
from 2 weeks ago, and the fourth column reviews data from 1 week ago. Arranging 
information in this manner may make reviewing the information more efficient. The 
enhancement to this feature is the ability to display the period dates within the columns. Select 
the Show Ranges checkbox to display the start and end dates of the period in the column 
heading. Select the Show End Date checkbox to display the end date of the period in the 
column heading. 
 

Scan a Report to Insert as Backdrop  
If you have been in Report Maker trying to recreate an intricate report, you will want to learn 
this trick. If you have access to a scanner you may scan the report and insert it into the Report 
Maker canvas as a backdrop. This saves you time from creating all the text fields, frames, lines, 
and such! All you need to do is layer on the proper demographic and view fields. The trick to 
getting this to function is: 1) have a quality scanned image and 2) save the image in .jpeg 
format. 
 

Report Tasks 
Report tasks can be very useful to all staff. In the example of transfers, it is beneficial to create 
transfer tasks for the end users. Some facilities send different information for different transfer 
types. For example, when a resident is transferred to the hospital the medical records staff 
may be required to send: 1) the face sheet, 2) the physician orders list, 3) a MAR from the past 
7 days, 4) a transfer summary report, 5) insurance information, and 6) advanced directives. 
Some of this might require photocopying in your current system but it does not have to. You 
can create a report task that pulls all 6 of these documents into one easy to print Transfer to 
Hospital button on an Access screen. 

Another example is a resident being transferred back to their assisted living apartment. With 
this transfer the medical records staff may be accustomed to printing/copying: 1) the face 
sheet, 2) discharge orders, 3) a MAR for the past 7 days, and a 4) discharge summary report. 
Again, this can all be set to print with one touch of a button from an Access screen. To create a 
report task, follow the steps below. 

1. Click on the green Reports icon. 

2. Do not select a client and click OK. 
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3. Holding CTRL on the keyboard, select the appropriate Report Maker reports. 

• NOTE: MARs are not included in the Report Maker reports if you are using the 
electronic MARs. 

4. When all the reports have been selected, click Tasks. 

5. Click Save. 

6. Name the task and click OK. Specify which sites and which user groups will need 
access to the task. 

7. Find the task in the task list, highlight it, and click Edit. 

8. Click Add under the Sign Tasks window to add a defined MAR to the report task. 

• Any date selections chosen here will be applied toward all reports in the task. 

 
 
 


